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Kurzweil 3000 v.9.x (Windows) 
 
Using Study Skills Tools to Support Reading Comprehension 
 
Introduction 
 
Kurzweil 3000 has many customizable features which support students who struggle 
with reading and writing.  The program’s text scanning and reading features make it a 
powerful tool for students who need support with content reading tasks.  Textbooks and 
novels can be scanned, the material read aloud, and e-highlighters used to identify and 
extract main ideas, supporting details or important vocabulary.   This tutorial will show 
you how to use these study skills tools to enhance and develop your students’ content 
reading comprehension. 
 
Case Study 
 
Students of all ages can benefit from the study skills tools built into Kurzweil 3000 .  
Once a compatible scanner has been connected and set up, students can scan 
documents by simply clicking the “Scan” button on the main toolbar.  This is particularly 
useful when the textual material being used in class is beyond the student’s ability to 
read and comprehend it.    
 
Jeremy is a Grade 5 student who is reading at a beginning Grade two level.  His team 
was struggling to provide reading material that was age and curriculum appropriate and 
still within his ability to read, understand and remember it.  His confidence and 
motivation was suffering as he was not able to complete the same content tasks as his 
peers without a great deal of Special Ed assistance.  At the same time, he was 
beginning to resist that help as it made him appear different from his classmates.  His 
team thought a software solution that would help him independently “read” and 
understand the Grade five texts and novels would really help. 
 
The team began implementing Kurzweil 3000 on a desktop computer at the back of 
Jeremy’s classroom.  They obtained an Epson 1670 scanner and had their IT 
department connect it to the computer.  Once they had trained themselves on the use of 
the scanner and Kurzweil program, they showed Jeremy how to scan pages in his Social 
Studies textbook.  He was able to use the text reading tools completely independently 
(using headphones) and the e-highlighters to select parts of the text depending on the 
task assigned by the teacher.  Once his team set up the highlight extraction parameters, 
he was able to extract his highlights and use these “notes” for studying and 
remembering the material.  His team frequently allowed peers to work with him using the 
program since one of the main curricular goals for the whole class was to learn how to 
identify main ideas and supporting details in content material.  Jeremy’s performance on 
assignments and tests improved significantly, but, more importantly, his general 
motivation increased and he required far less individual SEA support during the day. 
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Learning Objectives 
 
Completion of this tutorial will give you experience with the following: 

• Setting up scanning preferences 
• Scanning a document 
• Using and adjusting the text reading features 
• Using the Dictionary reference tool 
• Using the e-highlighters to select text 
• Extracting highlights to a separate document 

 
Installing Kurzweil 3000 (Windows) 
 
Before beginning this tutorial, please refer to the Installation instructions that came with 
your Kurzweil 3000 program.  Before you are able to use your program, you must 
register your copy either by phone or online (these instructions also came with your 
program). 
 
Connecting Your Scanner 
 
Before you are able to scan documents in Kurzweil 3000, you must obtain a Kurzweil 
compatible scanner (a list of compatible scanners is available from the Kurzweil website 
at http://www.kurzweiledu.com) and install the scanner drivers.  These drivers can be 
installed from the CD-ROM that comes with your scanner, or by downloading the drivers 
from the scanner company’s website.  It is often preferable to do the latter to ensure you 
get the absolute latest drivers.   
 
It is important to note that the Windows operating system allows you to plug in your 
scanner before you install the drivers and you will be prompted to allow your system to 
search for the drivers.  Have the CD-ROM inserted in the computer’s drive or already 
have the drivers downloaded from the company website and then browse to the driver 
location when asked. 
 
Once you have the scanner connected and the drivers installed, you can proceed with 
the tutorial… 
 
Starting the Program and Setting Up the Scanner 
 

1. Launch Kurzweil 3000  by double clicking the alias on your desktop or 
selecting it from your “Start – All Programs” list. 

 
2. When the “Tip of the Day” window opens up, close it by clicking in the “red 

close box” in the upper right corner of the window. 
 

 
 
 
 
 
 



 
Provincial Software Acquisition Plan  January 2006 3

 
3. Under the “Scan” menu, select “Scanner 

Setup” and “Select Scanner”. 
 
 
 
 
 
 

 
 
 
 
 
A small window with a list of installed scanners will 
open.  If you only have one scanner installed, you will 
only be able to select it.  If you have others, select the 
scanner you have connected from the drop down list.  
 
Click “OK” when your scanner is selected.  
 

4. Go back to the “Scan” menu and select 
“Scanner Setup” and “Scanner 
Optimization”.  

 
A window will open which will allow you to make some 
choices that will optimize your document scans.  This 
window is quite self-explanatory – notice that by 
optimizing the scans, you could add considerable time 
to your scanning task (e.g. optimizing the brightness 
will require 7 scans).  In general, you can get very 
satisfactory results without choosing any of these 
options.  However, it is important to know where to go 
if you are finding your scans need optimization. 
 
For now, do not select any of the options, and click “Exit” to close this window.  Your 
scanner should now be set up and ready to be used. 

 
Scanning a Document 

 
Scanning documents is very easy once your scanner is set up.  Place the textual 
material to be scanned on your scanner (face down). 
 

1. Click the “Scan” button on the Main Toolbar, go to the “Scan” 
menu and choose “Start New Scan” OR press “F9” on your 
keyboard.  

 
The scanner should initialize and scan the document.  You should see the document 
appear in the Kurzweil 3000 window.  While the scanner is scanning, the “Scan” button 
changes to “Cancel Scan” allowing you to stop the scan while it is in progress. 
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Setting Scanning Options 
 

Depending on how your scan turned out, you may want to make some adjustments to 
the Scanning options.  To do this… 
 

1. Go to the “Tools” menu and select “Options”.   
 
 
 
 
 
 
 
 
The “Options” window will open up.  Click on “Scanning” on 
the left side of the window to see the options available for 
scanning.  Here are some of the options you can choose… 
 
 
Brightness (increase brightness of scan) OCR Engine (to improve accuracy) 
 

 
 
Repeat scan 
delay (for scanning 
multiple page documents) 
 
 
 
Page orientation 
(in case the document is 
placed incorrectly on 
scanner) 
 
 
Extras 

• Find columns (for textbooks, etc. with text in columns) 
• Deskew (for making slight adjustments to scan alignment if paper is not quite 

straight) 
• Despeckle (for scanning dark or speckled paper like newsprint) 
• Dynamic Thresholding (for automatic adjustment of thresholds on the different 

regions of the page) 
 

2. Click “Apply” if you make any changes and then click “OK” to close the 
Options window. 

 
For more information on scanning, go to the “Help” menu and select the “Scanning” 
link. 
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Saving a Scanned Document 
 
Once you have scanned your document, you should save it to a location on your hard 
drive that is easy to find.   
 

1. With your document open, go to the “File” menu and select “Save” or “Save 
as…”.  The “Save as…” window will open up. 

 
 
By default, Kurzweil saves to 
the Kurzweil 3000 folder in 
the KESI folder in the My 
Documents folder. 
(path: My Documents – KESI 
– Kurzweil 3000) 
 
You can see the Sample 
Documents folder here as 
well. 
 

2. To create a new 
folder to hold your 
own scanned 
documents, click on the “Create New Folder” icon at the top of the window 
and name your folder. 

 
3. Double-click on the actual folder you created to open it.  Its name should now 

appear in the “Save in:” field at the top of the window. 
 

4. Click in the “File name” field and type in a name for your scanned file. 
 

5. The next step is important:  You must decide in what format your file will be 
saved.  There is a “Save as type:” drop down menu which gives you file 
format choices. 

 
By default, Kurzweil will save the 
file as a “KESI” file.   
If you save it this way, you will 
only be able to open the file with 
Kurzweil 3000. 
 

If you think you will need to open your file with another program (for example you may 
be transferring it to another computer), then you should consider another file format like 
“.DOC”. However, it is important to note that saving the file as another format will alter 
the content – likely removing the graphics on the page and saving the text only.  In 
addition, any annotations or highlights may not be saved either. 

 
It would be helpful at this time to save the same scanned document in the various 
formats so you can see what is retained or changed from the original scanned 
document. 
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Reading the Scanned Document 
 
We are now going to explore Kurzweil’s text reading tools.  Students who struggle to 
understand the printed word can really benefit from having the text read aloud and the 
ability to control how that text is read to them. 
 
For the remainder of the tutorial, we will be using a sample scanned file that comes with 
the Kurzweil 3000 program. 
 

1. On the Main Toolbar, click the “Open” button OR go 
to the “File” menu and select “Open…”   

 
You may need to move up a folder level – 
you are looking for the “Sample 
Documents” folder in the Kurzweil 3000 
folder.   
 
Double click on the “Sample Documents” 
folder to open it. 
 
Double click on the “Time Travel” file. 
 
 
 
 
 
 
 
 
 

2. The default toolbar set up for 
Kurzweil is “Classic”.  There is a 
toolbar set up that has been 
specifically designed for content 
reading.   

 
To access that set up, “right click” anywhere 
on the existing toolbars, select “Apply 
Toolbar Set” and then “Content Reading”. 
 
Notice that the toolbars change, placing the 
most obvious tools for content reading on the 
Main and Reading Toolbars. 
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3. Click to place your cursor next to the title of the scanned 
document – Time Travel.  Click the “Read” button on the 
Main Toolbar to have the text read aloud.   

 
 

Click the “Pause” button to stop reading.   
 
 

4. You can adjust the speed of reading by clicking the “up” and “down” red 
arrows on the Reading Toolbar or by typing in a specific “WPM” speed. 

 
5. You can also check the definition of any word in the document.  

Double-click the word “possible” near the top of the text to 
highlight it.  Click the “Definition” button on the Main Toolbar.  

 
A new document window opens with the definition of the word listed.  You can use 
the text reading tools to read that definition aloud as well. 
 
If you don’t like the vocabulary level 
used for the definition, you can select a 
different dictionary.  Go to the 
“Reference” menu, select “Select 
Dictionary” and choose the 
“American Heritage Children’s” 
dictionary. 
 
Try double-clicking possible again and 
then clicking the “Definition” button. 
 
You will see that the definition 
vocabulary has been adjusted. 

 
 
 
 
Highlighting the Scanned Document 
 
On the Content Reading Main Toolbar you can see two eHighlighters – yellow and 
green.  These can be used to virtually highlight main ideas and supporting details in the 
text. 
 

1. Click on the “yellow” highlight button.  Find some text that 
would be considered a main idea, click and drag through 
that text to highlight it in yellow.   

 
Continue along, highlighting other main 
ideas in the text. 

2. Click on the “green” highlight button and 
highlight text that would be considered 
supporting details.   
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3. If you have a student that would have difficulty remembering the purpose of 
each of the highlighters, you can assign names to them.  To do this, go to the 
“Tools” menu and select “Options”.  Click on the “Highlighters” page (on 
the left list).  You will see the following window: 

 
 
You can type the name of the 
highlighter in the appropriate 
fields.  
 
When you have changed the 
names of the yellow and 
green highlighter (to Main 
ideas and Supporting details), 
click “Apply” to save the 
changes and then “OK” to 
close the window. 
 
 
 
Notice that the names of the highlighters on the toolbar haven’t changed, 
but, if you roll your cursor over each, the pop-up tooltip has the new 
name.   
 
 
Extracting the Highlights 
 
Now that you have highlighted the main ideas and supporting details in the document, 
you can extract these highlights to create a 
summary or study notes document. 
 
1. Go to the “File” menu and select 

“Extract…”.  The “Extract” window 
opens up allowing you to specify 
which highlights you want to extract 
and how you want the highlighted 
text to be set up in the new 
document.  Here is how you should 
set up this window… 

 
Click next to “Highlights”  
Select “Main ideas”  “Supporting details” 
 
Leave Main ideas indent to 0.00 in 
Add the “%1. “ prefix to Main ideas 
 
Add 0.5 in indent to Supporting ideas 
Add the “%a. “ prefix to Supporting ideas 
 
Click “OK” to close the window and extract. 
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A new document with the extracted highlights opens up and should have the highlights 
arranged as you determined in the previous set up. 
 
Yellow highlight 
 No indent 

1. prefix 
 
Green highlight 
 0.5 in indent 
 a.  prefix 
 
Once you have established the extraction setup, each time the student extracts the 
highlights, it will look like this.  If you add other highlighters or change the purpose of the 
highlights, you may want to go in and adjust the extraction set up accordingly. 
 
This new document can then be read aloud, saved, printed and so on depending on how 
your student will be using it. 
 
Activating the Full Study Skills Toolbar 
 
If you find that the Content Reading Toolbar set up does not contain enough study skills 
for your student, you might consider displaying the full Study Skills toolbar (not currently 
visible).  To do this… 
 

1. “Right click” anywhere on the visible toolbars.  
Select “Study Skills” and “Large”. 

 
By default, the Study Skills Toolbar has a number of tools, 
including the full set of eHighlighters and a number of 
annotation tools that would allow your student to add 
“Sticky Notes”, “Text Notes” and “Voice Notes” to the 
scanned document. 
 

 
 
Please refer to tutorials and demonstrations on how to use these annotations to support 
“Test Taking and Worksheet Completion” available in the Kurzweil 3000 resource area 
(http://www.setbc.org/setbc/psap_lc/docs/05_kurzweil_resorce.html)  
 
Hopefully you feel confident at this point using Kurzweil 3000  to support and improve 
your students’ reading comprehension of content material. 
 
 
 
 


